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								horst siegert
							

							User
	Posts: 35
	Joined: Fri Dec 16, 2011 10:07 pm



		
						

						
						Multiple Pages to one document
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by horst siegert » Thu Apr 19, 2012 9:04 pm
			

			
			
			
			Hi,

how can I achieve, that the scanning of multiple pages will create one document and not multiple?

Thank you, horst
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								Walter-Tracker Supp
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	Posts: 381
	Joined: Mon Jun 13, 2011 5:10 pm



		
						

						
						Re: Multiple Pages to one document
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by Walter-Tracker Supp » Thu Apr 19, 2012 9:36 pm
			

			
			
			
			If you have a scanner with document feeder, you can do this directly from File->NewDocument->From Scanner...



If you only have a flatbed, you can scan multiple images into the dialog accessed from File->New Document->From Images.  Just click the "import" button at the bottom of the page and repeat until you have added all of the scanned pages you want.



You can also scan to a set of images in a directory, and then import these images into a single PDF file with PDF Tools or the Viewer.



-Walter
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						Re: Multiple Pages to one document
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						Post
					
								by horst siegert » Thu Apr 19, 2012 10:07 pm
			

			
			
			
			Hi Walter,

thank you for the response, but
Walter-Tracker Supp wrote:...  and then import these images into a single PDF


that is not so very elegant, I did in a similar way, and ...
Walter-Tracker Supp wrote:... and repeat until you have added all of the scanned pages you want. ...


this sounds good, but is crashing / freezing after scanning the first page.

horst
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								Chris - Tracker Supp
							

							Site Admin
	Posts: 795
	Joined: Tue Apr 14, 2009 11:33 pm



		
						

						
						Re: Multiple Pages to one document
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						Post
					
								by Chris - Tracker Supp » Thu Apr 19, 2012 11:59 pm
			

			
			
			
			Hi Horst,



What is the model of your Printer/Scanner? 



What version of Windows are you running, and is it 32 or 64 bit?



Do you have the latest version of your Printer/Scanner drivers installed?



And what version of the Viewer are you using? (Help->About)



These details will help us investigate your issue surther.



Thanks,

Chris


			
			
									
													If posting files to this forum - you must archive the files to a ZIP, RAR or 7z file or they will not be uploaded - thank you. 





Chris Attrell

Tracker Sales & Support North America

http://www.tracker-software.com
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	Posts: 869
	Joined: Tue Jun 09, 2009 3:53 am
	Location: Florida



		
						

						
						Re: Multiple Pages to one document
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by Arnold » Fri Apr 20, 2012 12:42 am
			

			
			
			
			I have used this method to scan in documents lately because if I scan using New Document From Scanner the document is never exactly Letter size. If I use New Document From Image File I can force it to be Letter size. But if I use the Import button to scan in a page (bypass the feeder) I cannot Import any more pages. The Import button is disabled after the first page. Is this a restriction of my scanner?



I am using a Brother MFC-295CN with Windows Xp sp3.
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								by horst siegert » Fri Apr 20, 2012 2:27 pm
			

			
			
			
			Chris - Tracker Supp wrote:
What is ...


Hi chris.

- The scanner: Medion MD 90090 (a very simple one but does the job for document scanning)

- Win 7 64 bit

- Latest driver is installed

- version 2.5 Build 201.0 (for scanning I'm using the 32 bit version as the scan-driver is 32 bit)

-

With my very old Acrobat 7 Standard I have no problems in scanning multiple pages to one document. But I really would like to ban that.

If helpfull, I can provide you with a screenrecording.

horst
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						Re: Multiple Pages to one document
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								by Paul - Tracker Supp » Fri Apr 20, 2012 3:49 pm
			

			
			
			
			Hi Horst,


version 2.5 Build 201.0 (for scanning I'm using the 32 bit version as the scan-driver is 32 bit)


can you tell me if you are using the portable version of PDF-XChange Viewer to do this?  You can't actually install a 32 bit Viewer on a 64 bit system as the exe installer will auto-detect your system architecture and install matching components and the 32 bit msi will not install on a 64 bit machine.



To use a 32 bit Viewer you need too use the portable version of the Viewer as it is always a 32 bit instance.  Is that what you are doing?


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Re: Multiple Pages to one document
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								by horst siegert » Fri Apr 20, 2012 5:13 pm
			

			
			
			
			Hi Paul,
Paul - Tracker Supp wrote:To use a 32 bit Viewer you need too use the portable version of the Viewer as it is always a 32 bit instance.  Is that what you are doing?


true! horst
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						Re: Multiple Pages to one document
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						Post
					
								by horst siegert » Fri Apr 20, 2012 8:01 pm
			

			
			
			
			Hi,

for a test I tried the 64 bit version and the WIA driver. That is ok (except that terrible inflexible driver software).

The 32 bit version of my standard pixel editor allows to scan mutliple documents in one go, with that scanner plus the 32 bit driver.

horst
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	Posts: 6869
	Joined: Wed Mar 25, 2009 10:37 pm
	Location: Chemainus, Canada
	
				Contact:
				
					
						Contact Paul - Tracker Supp
					
					
						


						
																																								
																	
										ICQ									
																																																
										Website									
																	

																					

					

				

			



		
						

						
						Re: Multiple Pages to one document
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								by Paul - Tracker Supp » Fri Apr 20, 2012 9:31 pm
			

			
			
			
			Thanks for that Horst,



it would appear that the issue is related to how our Viewer is communicating with that particular driver.  Given the vast number of scanners and drivers available we cannot practically investigate and customize for them all.  This is the reason for the WIA driver, it provides a common interface that precludes the need to do this.  



I'm afraid that we cannot do much about the 32 bit driver you are using and would suggest you use the WIA driver despite not liking it.  Sorry we couldn't be of more help here and I hope you can appreciate the reasoning here.



regards


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Re: Multiple Pages to one document
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								by horst siegert » Fri Apr 20, 2012 9:41 pm
			

			
			
			
			Paul - Tracker Supp wrote:...would suggest you use the WIA driver despite not liking it. ...


Doesn't matter. But I will scan to single documents / tabs and glue together. That WIA driver isn't offering the resolution I need and no 'pre-processing' of the scan.

Maybe version 3 allows to drag a tab and drop it to the preview  side bar   [image: :)]   ?

horst
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						Re: Multiple Pages to one document
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								by Paul - Tracker Supp » Fri Apr 20, 2012 10:29 pm
			

			
			
			
			Hi horst,


Maybe version 3 allows to drag a tab and drop it to the preview side bar [image: :)] ?



Can you explain in a little more detail, I'm afraid I don't quite understand what you mean.


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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								by horst siegert » Sat Apr 21, 2012 8:19 am
			

			
			
			
			Paul - Tracker Supp wrote:Can you explain  ... 


I'll do my very best  [image: :D]  :

- If I scan multiple page one after another, I get a row of tabs (New Document / New Document 1 / ... ) each containing just one page.

- If I select the tab 'New Document' the first page will be displayed.

- The left side bar shows the preview of that page.

- I still see the tabs of all the remaining pages.

- Dragging and dropping the tab 'New Document 1' below the preview of the still active 'New Document' will (my wish) attach 'New Document 1' to 'New Document' without clicking the menue for each page again and again.

horst
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							Site Admin
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						Post
					
								by Tracker Supp-Stefan » Mon Apr 23, 2012 11:21 am
			

			
			
			
			Hello Horst,



Have you seen this KB article on the subject:

How do I Move pages between opened documents in the Viewer



And also make sure to check this easier way to create a single PDF file directly from multiple scanned pages:

How do I scan multiple pages to a single PDF document?



Best,

Stefan
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						Re: Multiple Pages to one document
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								by horst siegert » Mon Apr 23, 2012 6:51 pm
			

			
			
			
			Hi Stefan,

this
Tracker Supp-Stefan wrote:
How do I Move pages between opened documents in the Viewer


is doing the job, I did it in a wrong way, thank's, horst
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						Re: Multiple Pages to one document
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						Post
					
								by Paul - Tracker Supp » Mon Apr 23, 2012 8:01 pm
			

			
			
			
			Hi Horst



thanks for the feedback.  You will save yourself quite a bit of time if you use the other article Stefan mentioned, it will allow you to import all your pages into a single PDF and not have to drag them around after the fact to combine them.



hth


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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								Vasyl-Tracker Dev Team
							

							Site Admin
	Posts: 2353
	Joined: Thu Jun 30, 2005 4:11 pm
	Location: Canada



		
						

						
						Re: Multiple Pages to one document
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						Post
					
								by Vasyl-Tracker Dev Team » Mon Apr 30, 2012 7:18 pm
			

			
			
			
			Hi Arnold.
I have used this method to scan in documents lately because if I scan using New Document From Scanner the document is never exactly Letter size. If I use New Document From Image File I can force it to be Letter size. But if I use the Import button to scan in a page (bypass the feeder) I cannot Import any more pages. The Import button is disabled after the first page.


It looks like a bug.. We will check and fix it in the next build. Thanks.



Best

Regards.


			
			
									
													Vasyl Yaremyn

Tracker Software Products 

Project Developer



Please archive any files posted to a ZIP, 7z or RAR file or they will be removed and not posted.
			
						


		


				
						
				
				Top
			
					

		
		

	


				
		

			
				


																			

								samoht
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						Re: Multiple Pages to one document
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						Post
					
								by samoht » Tue May 01, 2012 4:50 pm
			

			
			
			
			Scanning multiple pages into a single PDF file is something I have wanted for a long time.  So I was excited to see the comment from Stefan posted on Apr 23, 2012. Stefan commented: "And also make sure to check this easier way to create a single PDF file directly from multiple scanned pages: How do I scan multiple pages to a single PDF document?"



I have tried this and after I scan the initial image the "Import" button no longer works, ie, click button and no response.  I am using a C7100 All-in-one HP, XP SP3.  Have I missed something?
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						Re: Multiple Pages to one document
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						Post
					
								by Paul - Tracker Supp » Tue May 01, 2012 5:36 pm
			

			
			
			
			Hi samoht,



it's hard to say without seeing exactly what you are doing, but that button should ne available after the scan is complete.  Do you see your scan listed in the box or does that not happen either?



XP with SP3 should be a 32 bit OS so you should not have issues with it.  Can you humour me and try the Portable Version and let me know if you have the same results?



hth


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Re: Multiple Pages to one document
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						Post
					
								by samoht » Tue May 01, 2012 6:32 pm
			

			
			
			
			Paul - Sorry I wasn't a little more specific.  The initial scan appears in the box as an image file.  It is when I go to do another scan that, although the "import" button looks operative - and I can click on the down arrow by the import button and see my scanner (HP Photosmart C7100 TWAIN (TWAIN) - when I click on it nothing happens.  If I leave "New Document from Images" and return to it the functionality of the Import button is back.  But naturally I have lost the initial image.



Humor me, I will try the "Portable Version" later today.  Right now I am working on a Honey Do list  [image: :lol:]
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						Re: Multiple Pages to one document
		


														
							
								Quote
							
						


							
						
									
						Post
					
								by samoht » Tue May 01, 2012 6:55 pm
			

			
			
			
			Paul - Said the Honey Do list can wait for a couple of minutes and tried the portable version.  I installed and ran the portable version from within windows and the same thing happened.  BTW, made sure that no copies of the "regular" PDF X-Change Viewer were running.


			
			
									
													Thomas Simms
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						Re: Multiple Pages to one document
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						Post
					
								by Paul - Tracker Supp » Tue May 01, 2012 8:25 pm
			

			
			
			
			Thanks for doing that samoht,



it is quite likely that this is related to how the Viewer is communicating with the driver.  You said you are using the Twain driver.  Do you also have access to a WIA driver?  WIA is a standard Windows UI and less likely to have driver/device specific issues.  Can you make use of that or is the Twain your only option?



regards


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Post
					
								by samoht » Tue May 01, 2012 10:25 pm
			

			
			
			
			I've done a little research and it appears that the WIA drivers should be part of XP.  However, I cannot find how to "activate" them for the HP scanner.  It appears the only option is TWAIN.  I have tried to scan with Paint Brush, which apparently uses the WIA driver, but cannot since the acquire from scanner/camera button is grayed out.



If you have further suggestions I would be happy to hear them.
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								by samoht » Fri May 04, 2012 2:14 pm
			

			
			
			
			Has the above issue been closed? Or, is it still being researched?
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								by Paul - Tracker Supp » Fri May 04, 2012 3:35 pm
			

			
			
			
			Hi samoht,



this is still open.  We will try to get an update today.



thanks for your patience.



Paul


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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								by samoht » Fri May 04, 2012 3:55 pm
			

			
			
			
			Thank you Paul.


			
			
									
													Thomas Simms
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								by Paul - Tracker Supp » Tue May 08, 2012 2:08 pm
			

			
			
			
			Hi samoht,



this has been reproduced and a fix is being investigated.  We are hopeful for a fix for the next build but that remains to be seen .  I will update here when we have an solution.



Thanks again for your patience.



[image: :)]
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Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Post
					
								by samoht » Tue May 08, 2012 3:58 pm
			

			
			
			
			Thanks Paul.  Looking forward to the update.  This is a feature that I would use quite often and would save me some time.


			
			
									
													Thomas Simms
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								by Paul - Tracker Supp » Tue May 08, 2012 9:30 pm
			

			
			
			
			My pleasure samoht



I have raised a Support Request Ticket to track the progress. (Internal only)  



RT#1478: Multiple Pages to one document



We will update here as appropriate.


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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						Re: Multiple Pages to one document
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						Post
					
								by samoht » Mon Jun 18, 2012 4:34 pm
			

			
			
			
			Just downloaded the newest update (2.5 build 202) and wanted to comment that the multiple page to one document function now works for TWAIN copiers.  Thank you very much, will say me some time and hassle.


			
			
									
													Thomas Simms
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								by Paul - Tracker Supp » Mon Jun 18, 2012 4:42 pm
			

			
			
			
			Hi samoht,



thanks for the feedback.  I'm most pleased to hear this is now working for you.  The team put a lot of work into this build, I will for sure pass on the the message to them.  It's nice to be appreciated.



regards


			
			
									
													Best regards



Paul O'Rorke

Tracker Support North America

http://www.tracker-software.com
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